
SPREADSHEETS
They are used for organizing and analyzing numerical data. Microsoft excel is the gold standard which other
spreadsheet packages are designed to emulate. Before Microsoft excel reached the pinnacle of popularity, Lotus
123 was the spreadsheet program most widely used. They replaced the pencil, calculator and the columnar pad.
Examples are; Lotus 123, Microsoft Excel, STATVIEW, Quattro Pro, Easy Calc and General Schedule Calculator (GS-
Calc).
Uses of spreadsheet packages
They can be use for;

1. Statistical Analysis

2. Regressional Analysis

3. Financial Projection and Analysis

4. Stock Control Analysis

5. Mathematical Purposes

6. Accounting Purposes

7. Preparation of Examination Results.

8. Preparation of Daily Sales Report

9. Budget Management and Control

SPREADSHEET FEATURES AND TERMINOLOGIES
 Rows: They are the horizontal line of cells in a worksheet. They are usually identified by numbers which run

horizontally from left to right. They are numbered 1, 2, 3, 4 to 1,048,576.

 Columns: They are the vertical line of cells in a worksheet. They are usually identified by letters which run
vertically from the top to the bottom.. They are lettered A, B, C, D, then AA, AB, AC and ends in column XFD
making a total of 16,384 columns in Microsoft excel 2007.

 Cells: It is the intersection of a row and a column. Cells are identified by column header e.g B and the row
header e.g 2 to give the cell name B2, depending on the position of the cell pointer.

 Cell Pointer: It is the highlighted rectangle which users move to enter data. It is the cursor but referred to
as cell pointer in spreadsheet.

 Active Cell: It is the cell that contains the cell pointer. The name box always displays the active cell. The
active cell or default cell is cell A1.

 Active Worksheet: It is the worksheet where the cell pointer is currently located. The active worksheet or
default worksheet is sheet1.

 Worksheet: It is also called spreadsheet. It is the working area of the package where entering of data and
calculations are handled. It is also the collection of cells on a single sheet where data are kept and
manipulated. Worksheet consists of rows, columns, cells and cell pointer.

 Charts: it is the graphical representation of data. It makes data presented on a worksheet easier and
understandable. Examples are Column (Histogram), Pie Chart, Bar Chart, Line Chart, Scatter Diagram, Stock,
Surface, Doughnut and Bubble.

 Data Range: It is a group of highlighted cells in a worksheet.



 Workbook: It is the Microsoft Excel file in which users enter and store related data. The workbook is made
up of multiple worksheets. Each workbook can contain many worksheets.

ASSIGNMENT TWO (2)
List and explain fifteen (15) features of a typical Microsoft excel windows.
HOW TO LOAD OR OPEN A SPREADSHEET PACKAGE
METHOD ONE (1)

1. Click on the start button

2. Point to all programs

3. Point to Microsoft office

4. Click on Microsoft excel

METHOD TWO (2)
1. Right click on the desktop background

2. Point to new

3. Click on Microsoft excel

CREATING A NEW WORKBOOK
METHOD ONE (1)

1. Open Microsoft excel

2. Click on the office button

3. Select new

4. Click on create and a new workbook will be displayed.

METHOD TWO (2)
1. Open Microsoft excel

2. Press Ctrl + N

ENTERING VALUES
There are three types of entries in Microsoft excel and they include

 Labels: They are made up of texts that are entered into the active worksheet. Examples are letters or
alphabets (A-Z). Labels are left justified by default that is when they are entered, they automatically move
to the left of the cell.

 Numbers: they consist of digits from 0-9. By default, they are right justified on a cell. Both labels and
numbers are standard default or setting in MS excel though it can be reversed by the user.

 Formula: they are mathematical expressions which return calculated values.

EDITING ENTRY IN THE WORKSHEET
Editing a worksheet means either to insert some data, delete existing ones or to make corrections to the already
existing data. To do this, follow any step below;

1. Position your cell pointer to the cell you wish to edit, type the correct data and press enter.

2. Position the cell pointer on the cell you wish to edit and press the function key ‘F2’. It is called the edit key.
Delete the wrong data, type in the correct one and press the enter key.



3. Double click the cell you want to edit and type a new figure and press enter.

SAVING A WORKSHEET
METHOD ONE (1)

1. Click on Microsoft office button

2. Click on save

3. When the dialog box appears, in the save in box click on the arrow, a drop down menu appears.

4. Select My Documents.

5. Book1 is displayed in the File name box

6. Type “Mr. Peter” as the file in the file name box

7. Click on save

METHOD TWO (2)

EXITING THE SPREADSHEET PACKAGE
Make sure your work has being saved before taking any of the following steps
 Press ALT + F4

 Click on the file menu and select exit.

 Click on the close button on the title bar.

Graphs

It is a visual representation of the relations between certain quantities plotted with reference to a set of axes. One
powerful feature of the spreadsheet is its ability to create graphs/charts like:

 Line Charts
 Scatter Diagrams
 Bar Charts
 Pie Charts
 Histograms Column
 Bubble e.t.c.

Line Graphs or Line Charts

It is a type of graph that displays information as a series of data points connected by straight line segments. They
are commonly used in Excel. A line graph is most useful in displaying data or information that changes
continuously over time.

How to create a Line Chart

1. Highlight the Item Description and Quantity data ranges (X and Y axis).
2. Click the Insert Menu
3. Click on Line
4. Select the Line chart of your choice



Histograms

They are similar to bar charts. In a bar chart, the bars are of the same width while in a histogram, the bars can be
of varying width.

How to Create a Histogram

1. Load the Spreadsheet
2. Open the Calculation File
3. Highlight the Item Description and Quantity for the X and Y axis of the graph.
4. Click on the Insert Menu
5. Click on the Arrow beside charts
6. Select the Bar Option and then click on the Chart Format with Bars of Different Widths. Note: The histogram

and the bar charts are grouped together in Microsoft Excel (MS Excel)

Pie Chart

It is a circle graph that is divided into pieces, each displaying the size of some related piece of information. They
are used to display the sizes of parts that make up some whole. Only one column of data is required in creating a
pie chart in excel. There is no X and Y axis in the pie chart. If two columns are selected erroneously, then no chart
will be drawn, only the blank screen with a horizontal line will be displayed.

How to Create a Pie Chart

1. Click on the Insert Menu
2. Click on Pie
3. Select the Pie of your Choice

Bar Chart

In creating a bar chart, two groups of data are involved i.e. the X and Y axis.

How to create a Bar Chart

1. Highlight the Item Description and Quantity for the X and Y axis of the graph.
2. Click on the Insert Menu
3. Click on the Arrow Beside Chart
4. Select Bar and Click on the Chart of your Choice
5. Click on OK to Draw the Chart

Method Two

1. Highlight the Data Range you want to use for the Graph
2. Press the Function Key “F11” to Draw the Chart Automatically.
3. Use the Tool Bar to Format the Chart

Legends

It is a label that can be added to a chart to provide useful information, colour codes and so on about a chart. It
indicates what each bar or column or line or pie slice represents on a chart and are usually found beside charts. In
MS Excel, they are referred to as data labels. By defaults, they are labeled as Series1, Series2 e.t.c. and can be
renamed to user specific names.



How to Add Data Labels to Bar Charts

1. Right Click the Drawn Bar Chart
2. Click on Add Data Labels

How to Add Data Label to the Pie Chart

1. Right Click on the Pie
2. Select Add Data Label
3. Labels will be Displayed on all the Pies

Editing Graphs

This can be done by changing the values of the worksheet or by removing data from the worksheet.

Changing Values on the Worksheet

1. Open the calculation Worksheet
2. In the Cell that Contains the Value that you want to Change, Type a New Value. 3.

Press ENTER

Removing Data from a Chart

1. Click on the Chart
2. Click on Design Ribbon and click on Select Data Button
3. On the Displayed Select Data Source Dialog, Click on the Switch Row/Column
4. From the List of the Legend Entries, Click on an Item to Remove e.g Sir P
5. Click on the Remove Command

Formatting Graphs

1. Click on the Graph
2. The Toolbar Menu Displays Chart Tools Options
3. Click on the Format Option
4. On the Format Tab, in the Current Selection Group, Click the Arrow Next to the Chart Elements Box and then

Select the Chart Element that you want to Format.

On the Format Tab, Do Any of the Following

1. To Format any Selected Chart Element, in the Current Selection Group, Click Format Selection and then Select
the Formatting Options that you want.

2. To Format the Shape of a Selected Chart Element, in the Shape Styles Group, Click the style that you want or
Click Shape Fill, Shape Outline or Shape Effect and then Select the Formatting Options that you want.

3. To format the text in a Selected Chart Element by using WordArt, in the WordArt Styles Group, Click the Style
that you want or Click Text Fill, Text Outline or Text Effects and then Select the Formatting Options that you
want.

How to Change Font Colour of Pie Charts

1. Right Click on the Pie
2. Select Format Data Point
3. Click Fill
4. Select Picture or Texture Fill



5. Click on the Texture Button and Select the Texture of your Choice.

Changing the Colour of a Pie Chart

1. Click on the Drawn Pie Chart
2. Select the Colour of your Choice from the Tool Bar (Ribbon Bar)

COMPUTER SOFTWARE

Software, commonly known as programs, consists of all the electronic instructions that tell the hardware how to
perform a task such as word processing, recreation and database management e.t.c. They are also set of
programs that govern the operation of the computer system and make the hardware perform. It is also an
instruction that enables an otherwise dead machine to understand your input, and transform them into the desired
output. Software is written by a Programmer or Software Developer.

Types Computer Software

There are two (2) major types of computer software, they include;

1. System Software: It is a set of generalized programs that manage the resources of the computer such as the
processor, communication links and peripheral devices. A person or groups of persons who write system
software are called system programmers. Examples of system software are Operating System (e.g Linux,
Xenix, Microsoft Windows, Microsoft Disk Operating System (MSDOS), Personal Disk Operating System
(PCDOS), Novell Netware and Unix e.t.c), Language Translators (e.g COBOL, FORTRAN, Pascal, BASIC, Python,
Ruby, Perl, Ada e.t.c) and Utility Software (e.g Antivirus, Editors, Scandisk, Norton Utilities and Windows
Explorer).

2. Application Software: they are software written to perform specific task. They are target oriented i.e it is
specific to do the task it is designed for. Examples include Word processor (e.g Micosoft Word), Spreadsheet
(e.g Microsoft Excel), Presentation (e.g Microsoft Power Point), Database (e.g Microsoft Access), Accounting
(e.g Peach Tree or DacEasy) and graphic programs (e.g Corel Draw).

Operating Systems (OS)

It is a software consisting of programs and data that runs on computers, manages computer hardware resources
and provides common services for the execution of various application software.

Types of Operating Software

1. Graphical User Interface Operating System
2. Command Based Operating System
3. Single User Operating System
4. Multi-User Operating System
5. Network Operating System

Graphical User Interface Operating System (GUI)

These are OS with interactive features which make them user friendly and easier to use. Examples include
Microsoft Windows and Linux e.t.c

Command Based Operating System

This operating system communicates via a command utility. Special commands are used to access their features
and they require an expert. Examples are Unix and MS-DOS.

Single User Operating System

These are OS that are designed to manage the computer resources and allocates them to one user. Examples are



MS-DOS, Some Version of Windows OS e.t.c.

Multi User Operating System

These OS allows concurrent access by multiple users of a computer. It allows more than one user to run several
programs at the same time. The process of running more than one program concurrently (at the same time) is
called Multiprogramming. GUI and Command Based OS can be classified as a Multi User OS. Examples are UNIX
and XENIX e.t.c

Network Operating System

These OS links computers and users together to share resources and communicate with one and another.
Examples are Windows NT (New Technology), Windows Server 2003 e.t.c.

Functions of an Operating System

1. Booting: It is a process of starting the computer operating system as to enable the computer to work. It
checks the computer and makes it ready to work.

2. Memory Management: The memory cannot be managed without operating system. Different programs and
data execute in memory at one time. If there is no operating system, the programs may mix with each other
and the system will not work properly.

3. Loading and Execution: A program is loaded in the memory before it can be executed. Operating system
provides the facility to load programs in memory easily and then execute it.

4. Data Security: Data is an important part of computer system. The operating system protects the data stored
on the computer from illegal use, modification or deletion.

5. Disk Management: Operating system manages the disk space. It manages the stored files and folders in a
proper way.

6. Process Management: CPU can perform one task at one time. If there are many tasks, operating system
decides which task should get the CPU first.

7. Device Controlling: Operating system also controls all devices attached to computer. The hardware devices
are controlled with the help of small software called device drivers.

8. Printing Controlling: Operating system also controls printing function. If a user issues to print different
commands at a time, it does not mix the data and it prints them out separately.

9. Providing Interface: User interface controls how you input data and instruction and how information is
displayed on screen.

10. System Monitoring: Operating systems are used to monitor computer performance, debug problems, or

maintain parts of the system.

Human issues

Computer Professionals

Some of computer professionals are

 Data Processing Manager: A person who manages the resources of the computer center. His duty is to plan,



organize, coordinate, control and motivate the resources of the computer center so as achieve the goals and
objectives of the organization.

 System Analyst: An individual in charge of designing, modifying or analyzing various system to ensure
compatibility and user effectiveness. He ensures he keeps technical aspects of the company running smoothly.

 Computer Programmer: Someone who writes computer software. It refers to a specialist in one area of
computer programming or to a generalist who writes code for many kinds of software. One who practices or
professes a formal approach to programming may also be known as a Program Analyst.

 Computer Engineers: Someone who embeds computers in other machines and systems, build networks to
transfer data and develop ways to make computers faster, smaller and more effective. He ensures that the
computer is working as expected and he also maintains and repairs the computer.

 Computer Educator: Someone whose duty is to train people on how to use computer hardware and software.
He also teaches people on computer ethics and security so that people can work in the safest possible
environment.

 Computer Operator: A person who handles and operates computer hardware in a computer room. He must
have full knowledge on how to use the operating system installed in the computer. When the need arises, the
computer operator can call for help from the computer engineer or database administrator.

 Network Administrator: One of the chief jobs of a network administrator is connectivity. They ensure that
connectivity works for all users in their organization and making sure that data security is handled properly.

 Database Administrator (DBA): A person responsible for the design, implementation, maintenance and repair
of an organization’s database. The role includes the development and design of database strategies,
monitoring and improving database performance and capacity, and planning for future expansion
requirements. They may also plan, co-ordinate and implement security measures to safeguard the database.

Employers may require that a database administrator have a certificate or degree for database systems.

Data Processing Manager

Chief System Analyst Database Administration

System Analyst Database Designer

Chief Programmer Chief Operator

Programmer

Data Preparation
Supervisor

Data Entry Officer Computer Operator

Qualities of a Good Computer Professional

A good computer professional must abide by the code of ethics and professional conduct of the profession. The code of
ethics and professional conduct entails that computer professionals should:

1. Have an obligation to the public. It implies that professionals should not provide falsified information as well as
information that may pose danger to the public.

2. Have obligation to their employer or client. It implies that professionals should be loyal to their employers or clients and



they should keep confidential information of their employers without any third party.
3. Have obligation to their fellow members of the profession. This entails that professionals are expected to respect their co

-professionals and protect the interest of one another.
4. Have obligation to the country. It means that they should not practice any act that will jeopardize the country.

Qualities Expected from Person(s) Intending to Become a Computer Professionals

1. Good mathematical skills
2. Excellent analytical skills
3. Problem solving skills
4. Creative skills, e.t.c

Computer Professional Bodies

1. Computer Professionals Registration Council of Nigeria (CPN) founded in 1993
2. Nigeria Computer Society (NCS) formerly known as Computer Association Nigeria (COAN) founded in 1978
3. The Institute of Software Practitioners of Nigeria (ISPON) founded in1999
4. IT Industry Association of Nigeria (ITAN) founded in 1991
5. Nigeria Internet Group (NIG) established in 1995
6. National Information Technology Development Agency (NITDA) established in 2001
7. Internet Service Providers Association of Nigeria (ISPAN)
8. Nigeria Communication Commission (NCC)
9. Council for the Regulation of Engineering in Nigeria (COREN)
10. The Institute for the Management of Information Systems (IMIS)


